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History

Document Version

Changes

1.0
1.1

Upgrade information from German customer Wölfer added.

1.2

6-12-2012: Stop support for Xitron Interface card in Prepress 8.0.0.

1.3

13-12-2012:
- APR-60129: StoreFront Service is not installed during upgrade.
- A few updates concerning WebApproval related upgrades.
- Added general note on Server(s) and Satellite(s).
- Added in the PlateMaker upgrade the action to start the Installer (and also added possible
warning dialogs)
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Open issues



APR-59472: You cannot make new jobs after upgrading WebApproval Server. 2BVERIFIED



APR-59473: Reprocess of a webapproval jobs after upgrade. 2BVERIFIED



Customer upgrade Wölfer Germany: SupportFiles folder still contained old Apogee Prepress Clients.
Issue cannot be reproduced. To be verified in future upgrades. Recommend to take various screenshots
of the SupportFiles folder properties: sharing rights, folder contents, folder attributes, ... so that we can
find a reproducible scenario.
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General Notes

The provided checklist was created based on field experience of the upgrade installations done by HQ.
Please follow the described procedures as strictly as possible.
The total time required to complete an upgrade installation will be between a half and one day. This doesn't
include customer training.
Estimated time for backup actions:


30 - 60 minutes: Apogee Prepress Server



10 minutes: Apogee Prepress Satellite

Estimated time for upgrading an Apogee Prepress Server:


30 - 40 minutes: active jobs < 50 and SQL databases < 500 MB



40 - 50 minutes: active jobs < 250 and SQL databases < 1,5 GB



50 - 60 minutes: active jobs > 250 and SQL databases > 1,5 GB

Estimated time for upgrading an Apogee Prepress Satellite: 15 minutes.
Estimated time for performing the corrective actions: 30 minutes.
Estimated time for Installation of a new Apogee Prepress component: 15 minutes.
Estimated time for verification of Apogee Prepress workflow: 60 minutes.

Server(s) and Satellite(s)
When you find the text "Server(s)" or "Satellite(s)" or " Server(s) and Satellite(s)" than this means that you
need to perform this procedure only on the specified Apogee component. Keep in mind that a PlateMaker is
also a Server.

HQ - Mortsel
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Before starting the upgrade

Step

Action

1

Verify if you have the last version of this document (Published on Service Library - see History chapter).

2

Only Apogee Prepress 6.0.0 and Apogee Prepress 7.0.0/7.1.0 configurations can be upgraded. Older
Apogee configurations should be manually upgraded (use Configuration Manager to save all settings,
archive all jobs, uninstall current version, install new version, import settings via Configuration Manager
and import all job archives).

3

Xitron Interface cards are no longer supported in Prepress 8.0.0.
These should be replaced with EXPHYE64E Interface card or with the Ethernet to PIF Box..

4

Task Processors that are no longer supported (these need to be uninstalled before upgrading):
- Spice
- Packaging JDF Input Task Processor
- Step And Repeat Task Processor
- Digital Step And Repeat Task Processor

5

Verify if the necessary licensing conditions are fulfilled:
- An upgrade Receipt Code file is necessary when the customer doesn't have a Technology Contract.
- Customers with a transitional license should not upgrade.

6

Verify if the current Operating Systems are supported (Apogee Prepress Release Notes).
Verify also the required Service Packs.

7

Ask the customer to perform the "Customer actions prior to upgrading" in order to reduce upgrade time.

8

Make sure to take the Apogee Prepress 6.0.0/7.0.0/8.0.0 DVD's with you.

5.

Check

Customer actions prior to upgrading

Step

Action

1

Delete as many jobs as possible (archive them if necessary).

2

Delete as many documents as possible in the Public PageStore(s).

3

Answer as many Apogee Prepress messages as possible.

4

Run the Cleanup Dangling Jobresources script after production hours.
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Agfa Service actions prior to upgrading

Step

Actions which can be performed when Apogee Prepress is running (however customer should stop
processing jobs)

1

Copy the Apogee Prepress 8.0.0 32 bit DVD on the root of the hard disk of your current Apogee Prepress
Server and share this folder for Windows (approx. 4 GB free disk space is required).
CAUTION: Verify if the Apogee Prepress 8.0.0 32 bit DVD copy on your hard disk is not marked as ReadOnly: Context-click the Header of a Windows Explorer dialog (which usually only contains; Name, Size,
Type, Date Modified) and select Attributes. If the Attributes column contains an R then folders/files are
Read-Only. Go to Folder > Properties, deselect Read-Only and click OK. Select "Apply changes to this
folder, subfolders and files".
NOTE: DVD read/write copy errors might occur on some hardware platforms with initial DVD's that are
created in Mortsel HQ. We expect fewer problems with the DVD's that will be created in production.
You can also clear the Read-Only attributes via the command line utility "attrib -R *.* /s /d".
Error message "Update FLUID failed! ("D:\Agfa\Prepress\Server\...\$JOB")." Typically indicates that there
are Read-Only files.

2

Copy the latest installerfix on top of your Prepress 8.0.0 32 bit DVD
CONTROLLED RELEASE: check ftp:\\betatester:agfapogee@gs-ftp.agfa.be
OFFICIAL RELEASE: Apogee Prepress 8.0.0 - Hotfix Overview

3

Run the UpgradeAssistent.exe tool (located on the Apogee Prepress 8.0.0 - 32bit DVD):
Select File > Analyze System to investigate if there are potential upgrade issues (see UpgradeAssistent.pdf
document for more information).

4

Server(s) and Satellite(s): Perform the nslookup tests if the customer uses a DNS server: nslookup IPaddress should result in computer name, nslookup computer name (with and without domain name)
should result in IP-address.

5

Server(s) and Satellite(s): A ping command should be successful to any Apogee Prepress hardware system
(with and without the customer's domain name).

6

Make sure that the SQL database files and SQL software files are NOT compressed by Windows
(compressed files are indicated in blue). When some files are compressed then the last part of the
SQLExpress installation (removal) will fail.
To uncompress files:
- Stop all SQL Services (of course Apogee Prepress needs to be stopped first).
- Start command line utility and browse to the Program Files\SQL folder.
- Type "compact /u /s" to uncompress all files in current directory and subdirectories.
NOTE: typically there are SQL software files on C- and D-drive.

7

Corrupt Fonts might prevent the Task Processors from starting up correctly (depending on the Apogee
Prepress version you are using). Therefore you should delete corrupt Fonts prior to upgrading. Deleting
corrupt Fonts must be done via the Fonts resource of one of the "Font Database" Task Processors; System
Overview > PDFRender > Fonts resource. Fonts that are corrupt are shown in the Fonts list with a Font
name (first column) "Cannot find name". These Fonts cannot be used and should be deleted.

8

Check the limitations (next chapter) that apply to your configuration and take the necessary actions.

HQ - Mortsel
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7.

Limitations (final)
Limitations

Check

APR-59569: The Upgrade Installer does not preserve separately running StorageServers states
(sometimes this is done for performance and/or stability reasons). After upgrading the StorageServer will
no longer run separately. Take a screenshot of the running Apogee Prepress components, save it in the
"corrective actions" folder on your hard drive and name it "SeparateStorageServer.jpg".
The Upgrade installer does not preserve the state (started or stopped) of the Task Processors. All Task
Processors will be started after an upgrade. Take a screenshot of the System Overview, save it in the
"corrective actions" folder on your hard drive and name it "TaskProcessorState.jpg".
Root folders (ExportRoot, JDFImportRoot, ....) are retrieved from the Registry during upgrade installs.
Therefore Root folders that are manually changed after installation (stop sharing current Root folder,
remove Root folder, create new Root folder and share with same name) will not be detected during
upgrade installer.
We recommend uninstalling and re-installing the Task Processor to which the Root folder belongs and
define the new folder allocation during the re-install (Export Task Processor for ExportRoot, JDFImport
Task Processor for JDFImportRoot, ...).
Prepress
6.0.0

Prepress 8.0.0 does not provide a Borders resource for the Impose Task Processor (Stripping). Stripping
jobs will always be converted to Apogee Impose jobs in which the required Borders (Mark Sets) must be
defined. The upgrade installer does not convert the Impose Borders to Apogee Impose Mark Sets.
Therefore we recommend taking screenshots of the current Impose Borders and save these in the
"corrective actions" folder on your hard drive. After upgrade you should manually create the required
Mark Sets in Apogee Impose.

Prepress
6.0.0

The Generic Press Parameters (Plate/Press Media tab) of Prepress 8.0.0 will have a new option "Clip
Press Border Marks". This option will be by default enabled also for upgraded Generic Press Parameter
Sets. Therefore you might need to deselect this option in your upgraded Generic Press Parameter Sets.
APR-29020, APR-29066: The loaded media of all output devices Task processors which do not
communicate loaded media states with the physical device will be reset (all Proofers, TIFF PlateSetter
and TIFF ImageSetter). Take a screenshot of the loaded media of all devices and save them in the
"corrective actions" folder on your hard drive.
APR-46915: Proofer Color exceptions are not preserved.
Export the Proofer Color exceptions before starting the upgrade and save them in the "corrective actions
folder" on your hard drive.
APR-47447: Changes in the General Color Book are not preserved after the upgrade (renamed "Green" to
"Groen"). Take a Screenshot of the ColorBook and save it in the "corrective actions" folder on your hard
drive.

Prepress
6.0.0

APR-50074: After an upgrade it is possible that there are multiple Generic Press resources with the same
name. Example: before the upgrade you had two presses MAN and KBA, both presses have a calibration
curve called "CalCurve" (both curves are different but have the same name), those curves will still be
called "CalCurve" after the upgrade but now both available for the Generic Press. You cannot define in
job tickets which "CalCurve" needs to be used because it will only list one.
Verify if the following resources of your Press Task Processors have unique names: Borders, Calibration
Curves, Simulation Curves, WebGrowth Profiles and Color Profiles.
Therefore we recommend to rename these Press (we recommend to include the name of the Press in the
resource to make it unique) resources before the upgrade.
NOTE: a side effect of this change is that existing jobs, hot tickets and templates that uses those
resources will need to be manually updated.

Prepress
6.0.0

APR-52531, APR-53360: ICC Profile maps and Calibration Curve maps are not preserved during the
upgrade from Press to Generic Press. These maps can also not be imported via the Configuration
Manager. You need to manually recreate these maps. Take Screenshots of the maps and save them in the
"corrective actions" folder on your hard drive.

Prepress
6.0.0

APR-52363: There are two versions of some PDF /X Preflight Profiles after upgrade (second instance has
an additional "_" character).
- PDF X-1a 2001 v5 and PDF X-1a_2001 v5
- PDF X-1a 2003 v5 and PDF X-1a_2003 v5
Remove the first instance of the Preflight Profiles (the one without the additional "_" character).
APR-59451: Custom International Color names are not preserved after upgrade. Take a screenshot of the
International Colors, save it in the "corrective actions" folder on your hard drive and name it
"InternationalColors.jpg".
APR-59571: UpdateManager options settings are not preserved.
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Prep4Upgrade
1

Make sure Apogee Prepress is running however be aware that Apogee Prepress will be stopped during next
step in the procedure.
Server(s): Make a backup of the Apogee Prepress server using the prep4upgrade tool (located in the root of
the Apogee Prepress 8.0.0 DVD copy on your hard disk). Start the "prep4upgradeMain.exe" and click the
Backup button.
The prep4upgrade tool makes a backup of the Apogee Prepress registry keys, the Apogee Prepress
software, the System datastore and the SQL databases. The tool also starts the Configuration Manager
from the SupportFiles to make a Configuration Manager backup. The prep4upgrade tool requires at least
16GB (fixed value) of free disk space on the destination folder however the actual backed up data could be
less or more than 16 GB.
CAUTION:
- Make sure to select a backup folder on the root of a disk drive (ex. F:\Prep4UpgradeBackup).
- The prep4upgrade tool must be located on a hard drive. The tool does not have very good error recovery
therefore verify if there is a prep4upgradeMain.log file created in the folder where prep4upgradeMain.exe
is located. This log file might contain important errors. Open the log file especially when the backup or
restore operation takes much longer as expected. There are no errors when there is no log file.
- The prep4upgrade tool cannot be used towards a remote folder.
- Make sure that the prep4upgrade backup folder contains 5 subfolders after finishing backup procedure:
AGFA, ConfigMgr, DB, REG and SYSTEMDISK.
- Make sure that each folder (AGFA, ConfigMgr, DB, REG and SYSTEMDISK ) contains some files.

2

Satellite(s): Make a backup of the Apogee Prepress satellites using the Prep4upgrade tool.
Make sure that the Failover software is removed from the Satellite before running the Prep4Upgrade.
Multiple Satellites can be backed up simultaneously (by running the prep4upgrade tool on each of them).
When prep4upgrade is complete there should be two folders AGFA and REG. make sure that these folders
contain some files.

HQ - Mortsel
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9.

Upgrading the Apogee Prepress Server

Step

Action

Check

1

WebApproval and ProjectManager: Make sure to upgrade WebApproval and ProjectManager first.
Refer to WebApproval and ProjectManager upgrade checklist for correct procedure.

2

Satellite with Failover: Before starting the Prepress Server upgrade you should uninstall the Apogee
Prepress 6.0.0/7.0.0/7.1.0 Failover on your Satellite:
- Before starting uninstall of Failover, make sure that SQL Server software is still present (and running).
- Start > Control Panel - Add or Remove Programs.
- Select Apogee Satellite - Failover and click the Change button (this will start the Apogee Install wizard).
- Select Next > Modify > Next > Remove Failover but keep the Satellite.
NOTE: when Failover cannot be uninstalled and Removeserverdatabase warning is given you should be able
to continue. For every Database you will get a warning which needs you need to continue.

3

Server(s) and Satellite(s):
- Open the properties of the Apache Tomcat service: stop the service and set startup type to Manual.
- Open the properties of the SUMService: stop the service and change startup type to Manual.
- Make sure that the SUM.ProductStarter and the SUM.Manager process are no longer running (verify and
stop them via the Windows Task Manager when required).
- Open the properties of the Extreme Z-IP Service: stop the service and set startup type to Manual.
- Disable any scheduled scripts (Start-Programs-Accessories-System Tools-Scheduled Tasks).
- Disable anti-virus applications (make sure that the application is not restarted after hardware reboot
before or during upgrade installation process).
- Stop WebApproval and ProjectManager Server and subsystem(s).

4

Make sure that all replication folders (Storage set mirrors) are accessible during the upgrade process.
The Upgrade Installer might give an error when Apogee Prepress is not running (at times when we expect
that Prepress is running). In these scenarios the installer will start Apogee Prepress. You need to click the
Retry button after Prepress is started (wait until all Task Processors are started).
TAKE A SCREENSHOT IF YOU RUN INTO THIS SCENARIO AND PROVIDE IT TO BERT LEEMPOELS
APR-59456: Any Warning messages that occur during upgrade installer will have a Continue button
(example: the RemoveFileFolder() message). These should not cause any issues.

5

Server(s): Make sure you are the only active user (Administrator account): Task Manager > Users
(disconnect any users even the ones that are not active).

6

Stop the PlateMaker Server.
The actions to upgrade the PlateMaker Server are defined in a different chapter.

7

Server(s) and Satellite(s): disconnect any (output device) interface cable before installing Apogee Prepress
8.0.0 (the driver will not be installed when the interface is in use).

8

Start the Installer (from the Prepress 8.0 DVD copy on your hard disk). Apogee Prepress does not need to be
started.
Some Windows prerequisites might be installed before starting the upgrade installer.
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9

Confirm installer and license agreement. Follow the upgrade installer wizard.
A device driver wizard will be shown when upgrading sites with APIS devices).
NOTE: Click "Yes" to confirm that the UpdateManager Data folder will no longer be shared (if applicable:
not all UpdateManager Data folders will be shared).

10

A computer restart will be required after SQL upgrade installation is completed. NOTE: a computer restart
will not be required when you have SQL 2005/2008 Standard (Server) Edition installed. In this case do not
forget to perform the procedure "Upgrading to SQL Server 2008 R2 Standard Edition".

After restart the installer will automatically continue (it will be started before the Windows environment is
loaded).

11

Start the Client installer via the option provided by the upgrade install finish dialog.

12

Restart the computer.

13

Verify status of UpgradeJobs in c:\Windows\temp
- Open the installer log file (agfa_UJ_*.log)
- Verify if the last line is ‘Successfully finished JobUpgrader’
Refer to starting Job Upgrade manually (see solutions chapter) when Job Upgrader did not correctly finish.

14

Start the Apogee Prepress System.
Also the Registration Utility, Apache Tomcat and UpdateManager will have been updated.

HQ - Mortsel
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10. Upgrading the Apogee Prepress Satellite(s)
Step

Action

Check

Multiple Satellites can be upgraded simultaneously.
1

Make sure Failover is already uninstalled as mentioned in "Upgrading the Apogee Prepress Server".

2

Verify if the Apogee Prepress 8.0.0 Server is running and verify (when Apogee Prepress Server has multiple
network cards) that the ping command with Apogee Prepress Server hostname returns the IP address of
the network card on which Apogee Prepress is registered (see license or fingerprint file).

3

- Open the properties of the SUMService: stop the service and change startup type to Manual.
- End the SUM.ProductStarter.exe process via the Windows Task manager.
- Open the properties of the Extreme Z-IP Service: stop the service and set startup type to Manual.
- Disable any scheduled scripts (Start-Programs-Accessories-System Tools-Scheduled Tasks).
- Disable anti-virus applications (make sure that the application is not restarted after hardware reboot
before or during upgrade installation process).

4

Disconnect the USB2APIS box before installing Apogee Prepress 8.0.0 (the driver will not be installed when
the interface is in use).

5

Make sure you are the only active user (Administrator account): Task Manager > Users (disconnect any
users even the ones that are not active).
Start the Installer (setup.exe from the Prepress 8.0.0 DVD copy on the hard disk).
Some Windows prerequisites might be installed before starting the upgrade installer.

Confirm installer and license agreement. . Follow the upgrade installer wizard (a device driver wizard might
be shown when upgrading sites with APIS/SCREEN devices).
- Click "Yes" to confirm that the UpdateManager Data folder will no longer be shared (if applicable: not all
UpdateManager Data folders will be shared).
The Upgrade Installer might give an error (see below) which occurs when one of the Satellite Launchers
cannot connect to the Prepress Server. You need to click the Retry button. When the error dialog comes up
again, please verify your network connection as also described in Step number 2.

APR-59456: Any Warning messages that occur during upgrade installer will have a Continue button
(example: the RemoveFileFolder() message). These should not cause any issues.
6

Restart computer when upgrade installation finishes.

7

After upgrading all Satellites, stop the Apogee Prepress System and reboot all computers (Server and
Satellites). After reboot you can start Apogee Prepress System.
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11. Upgrading a PlateMaker Server
Step

Action

Check

1

- Stop WebApproval and ProjectManager Server and subsystem(s).
- Stop the Apogee Prepress Server: Apogee Prepress Server might otherwise try to access some resources
of the Apogee PlateMaker Server which can cause upgrade issues.
- Open the properties of the Apache Tomcat service: stop the service and set startup type to Manual.
- Open the properties of the SUMService: stop the service and change startup type to Manual.
- End the SUM.ProductStarter.exe process via the Windows Task manager.
- Open the properties of the Extreme Z-IP Service: stop the service and set startup type to Manual.
- Disable any scheduled scripts (Start-Programs-Accessories-System Tools-Scheduled Tasks).
- Disable anti-virus applications (make sure that the application is not restarted after hardware reboot
before or during upgrade installation process).

2

Make sure you are the only active user (Administrator account): Task Manager > Users (disconnect any
users even the ones that are not active).
Start the Installer (from the Prepress 8.0 DVD copy on your hard disk). Apogee Prepress does not need to
be started.
The Upgrade Installer might give an error when Apogee Prepress is not running (at times when we expect
that Prepress is running). In these scenarios the installer will start Apogee Prepress. You need to click the
Retry button after Prepress is started (wait until all Task Processors are started).
TAKE A SCREENSHOT IF YOU RUN INTO THIS SCENARIO AND PROVIDE IT TO BERT LEEMPOELS
APR-59456: Any Warning messages that occur during upgrade installer will have a Continue button
(example: the RemoveFileFolder() message). These should not cause any issues.

3

Confirm installer and license agreement. Follow the upgrade installer wizard.
A device driver wizard will be shown when upgrading sites with APIS devices).
NOTE: Click "Yes" to confirm that the UpdateManager Data folder will no longer be shared (if applicable:
not all UpdateManager Data folders will be shared).

4

A computer restart will be required after SQL upgrade installation is completed. NOTE: a computer restart
will not be required when you have SQL 2005/2008 Standard (Server) Edition installed. In this case do not
forget to perform the procedure "Upgrading to SQL Server 2008 R2 Standard Edition".

After restart the installer will automatically continue (it will be started before the Windows environment is
loaded).

5

Verify status of UpgradeJobs in c:\Windows\temp
- Open the installer log file (agfa_UJ_*.log)
- Verify if the last line is ‘Successfully finished JobUpgrader’
Refer to starting Job Upgrade manually (see solutions chapter) when Job Upgrader did not correctly finish.

6

After upgrade is finished successfully. A final reboot is required.

HQ - Mortsel
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12. Upgrading to SQL Server 2008 R2 Standard Edition
Step

Action

Check

SQL Server 2005/2008 Standard Edition is not upgraded automatically to SQL Server 2008 R2 Standard
Edition, this must be done manually.
1

Apogee Prepress should be stopped, SQL Server 2005/2008 Standard Edition should be running.
Start the SQL installer by double-clicking the AgfaSetup.exe file in the SQL folder on the SQL DVD.

2

After 10-15 minutes upgrade should finish successfully. A final reboot is required.

3

Run Apodiag and verify if SQL Server 2008 R2 Standard Edition was correctly installed (see Database > Info
- Edition).
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13. Upgrading the Apogee Prepress Clients
Step

Upgrading Windows Clients Action

Check

Verify if the current Apogee Prepress Windows Client Operating System is still supported (Apogee Prepress
release Notes - Operating systems chapter).
1

Install the necessary Windows Clients (Prepress PlateMaker and QMS). The Apogee Prepress Windows
Client installer will upgrade your Apogee Prepress 6.0.0/7.0.0/7.1.0 Windows Client.
REMARK: the client preferences from previous versions are preserved and used.
LIMITATION:
APR-56926: Running the Client Upgrade Installer in custom mode (not typical) will trigger a calculation of
the required disk space. This calculation takes a considerable amount of time (at least 1 minute). During
this time the client seems to be unresponsive. Do not try to make changes in the installer during this time,
just wait until the calculation is finished.

Step

Upgrading Macintosh Clients Action

Check

Verify if the current Apogee Prepress Macintosh Client Operating System is still supported (Apogee
Prepress release Notes - Operating systems chapter).
1

Install the necessary Macintosh Clients. The Macintosh Client installer will upgrade your previous Client
version.
CAUTION: the old Apogee Prepress Acrobat plug-ins are not always correctly removed.
REMARK: the Macintosh client preferences are not preserved.

14. Re-license the Apogee Prepress System
Reprocessing (or processing) jobs will not work when you have not re-licensed.
Step

Re-licensing actions with Technology/Workflow Care Contract (with or without Transitional
license)

1

Save a Fingerprint file after upgrading and upload this Fingerprint file to the ELMS.

2

Install the updated license file which the ELMS has generated.

3

Restart Apogee Prepress after licensing.

Step

Re-licensing actions without Workflow Upgrade Contract (Technology)/Workflow Care Contract

1

Save a Fingerprint file after upgrading.

2

Open this Fingerprint file and add the (Upgrade) Receipt Code file in the Registration Utility.

3

Create a License Request File and upload this file to the ELMS.

4

Install the updated license file which the ELMS has generated.

5

Restart Apogee Prepress after licensing.

HQ - Mortsel
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15. Corrective actions after upgrading
Step

Corrective actions for all upgrade installs

Check

Open the Corrective Actions folder on your hard disk. Open each Screenshot and adjust/correct all settings
that the upgrade installer did not preserve.
1

All WebApproval jobs will have a warning icon. You need to open the warning and click the Process button
in order to re-create the WebApproval job on the WebApproval system.

2

Apogee Prepress shortcuts which are manually created might need to be adjusted.

3

Import the Proofer Color exceptions from the "corrective actions folder" on your hard drive (when
applicable).

4

Verify if all Services are started and set to startup type Automatic: Apache Tomcat, SUMService and
Extreme-Z-IP.

5

Perform a "Server Consistency" verify and update action after the upgrade to bring all Parameter Sets, Hot
Tickets and Ticket Templates in sync.

6

APR-53234: Create a test job with a PrintDrive Output device and a Press which is set to Gray Printing.
Process a sample file and test all PrintDrive Output Parameter Sets.
The used PrintDrive Output Parameter Set needs to be deleted and manually recreated (select the Initial
Parameter Set and select New) when the following error occurs during processing "Error message:
Colormodel, [(\357\273\277Gray)] cannot be set".

7

APR-53385, APR-59095: Delete all old Hotfixes that are not removed automatically from
the"UpdateManager Data\Available", "UpdateManager Data\Installed" or "UpdateManager
Data\Trashcan" folders.

8

Please adjust your InkSave parameters according to the specification made in "TN-Apogee Prepress 8.0
InkSave - Application guidelines and limitations".

9

It might be required to create users due to the User Privileges implementation. Refer to the Apogee
Prepress 8.0 Release notes for more information on User Privileges.
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16. Re-installing the Failover
Step

Action

Check

1

Uninstall the Failover software if this is not already done and then restart the computer.
NOTES:
- SQL Express/Standard Server should not be uninstalled.
- When Failover cannot be uninstalled and Removeserverdatabase warning is given you should be able to
continue. For every Database you will get a warning dialog for which you need to click continue.

2

Install Failover as specified in Installation Guide.

17. Verification actions
Step

Action

Check

1

Reprocess some of the upgraded jobs (upgrade license must be loaded first).

2

Import some of the Apogee 6.0.0/7.0.0/7.1.0 Job archives and reprocess these jobs.

3

Verify all used active Hot Tickets and Ticket Templates
NOTE: some tickets might need adjustments, refer to the changes by design chapter of the Apogee
Prepress 8.0.0 Release Notes .

18. Last actions before leaving the customer site
Step

Action

Check

1

Enable anti-virus applications on Server(s) and Satellite(s).

2

Restart all scripts on Server(s) and Satellite(s).

3

Run the cleanup dangling jobresources (Apogee Prepress Monitor – e: Resources – d: Cleanup dangling
jobresources).

4

Run Apodiag tool (shortcut on desktop) and correct any issues that Apodiag reports.

5

Schedule a full backup of the SQL database (at least three hours after the cleanup dangling jobresources).

6

Schedule to backup all settings via Apogee Prepress Configuration Manager (Configuration Manager
supports command line so batch file can be created).
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19. Restore procedure when upgrade installer doesn't work
NOTE: Restoring Server and Satellite(s) can be done simultaneously.
Step

Restore the Server action

1

Stop the Apogee Prepress System, Apache Tomcat Service and Apodiag.

2

Perform the Restore action with the prep4upgrade tool (located on the Apogee Prepress 8.0.0 DVD copy on
your hard disk). Select the folder with backup data which you used during the Backup action with
prep4upgrade.
The following applications will not be restored: Microsoft SQL, UpdateManager, Registration Utility and
Apache Tomcat.

3

Restart the computer.

4

You cannot start the Prepress System with the PrepressManager because this application will use
components of the UpdateManager (which is running the latest version and not compatible with your
restored Prepress System).
You could install the old UpdateManager however if you only need the restored system for a short time
then you could start Apogee Prepress with the Launcher.bat files (located in Agfa\Prepress\Server).

5

Any sites using JDF communication will also need to install the previous Apache Tomcat version:
- Uninstall the Tomcat version that is installed by the upgrade Installer
- Install old Tomcat from the 6.0.0 or 7.0.0 DVD (procedure is different for both cases):
(use the default settings when re-installing only change the required port number to 80)
6.0.0 DVD\Installers\JMFWebServer run apache-tomcat-6.0.16.exe.
7.0.0 DVD\Installers\JMFWebServer run Install_Apache_Tomcat6.vbs
- After installation context click the Tomcat icon (windows launcher bar right corner of your screen) and
select Configure...
-Select JAVA tab and replace Java Virtual Machine field with "C:\Program
Files\Java\jre1.5.0_15\bin\client\jvm.dll"
- Restart computer

Check

You might need to re-license your server. An old license file is available in the folder that you used for the
Prep4Upgrade Backup (see DB subfolder).
WARNING: You cannot adjust your restored 6.0.0/7.0.0/7.1.0 system (add or remove Task Processors).

Step

Restore a Satellite action

1

Make sure that the Apogee Prepress System is not running.

2

Make sure that the Prep4Upgrade folder is copied to a local disk of the Satellite (do not run Prep4Upgrade
- Restore action remotely).

3

Perform the Restore action with the prep4upgrade tool.
Select the folder with backup data which you used during the Backup action with prep4upgrade.

4

Restart the computer.

5

Start the restored Satellite with the launcher.bat file as mentioned above in the "Restore the Server".

Step

Restore Apogee Prepress Clients

1

Uninstall Apogee Prepress 8.0.0 Clients.

2

Install Apogee Prepress 6.0.0/7.0.0/7.1.0 Clients.

Step
1

Provide feedback of failed upgrade action

Check

Check

Check

Compress (zip) the complete Apogee Prepress 6.0.0/7.0.0/7.1.0 backup folder which was made by the
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prep4upgrade tool and save this data on DVD.
2

Create a ServiceXPress/Powerhelp record to report the upgrade-issue.

3

Write the ServiceXPress/Powerhelp INC number on DVD and sent to:
Agfa Graphics - Geert Van Assche (ext. 3555)
Septestraat 27, 2640 Mortsel, Belgium
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20. Cleanup Tools
Step

Installing the Cleanup Tools

1

Extract the UninstallProcedure.zip file in Apogee Prepress DVD\Installers\RND_Uninstall.

2

Extract MSICleanup.zip and start msicuu2.exe to install Windows Install cleanup utility.

3

For other tools refer to Service Guide.

Step

Windows Install Cleanup Utility

1

Start > Programs > Windows install cleanup.

2

Select the application which you want to remove and click uninstall.

TechNote - Company confidential

Check

Check

HQ - Mortsel

20 of 32

UPGRADE CHECKLIST - APOGEE PREPRESS 8.0.0

21. Solutions
Starting Job Upgrade manually
1

Set JobStore in No Recovery mode via the Service Tool > Core Server (a) > JobStore NoRecovery mode (p) >
Registry Key (a).
NoRecoveryMode is now Enabled.

2

Start Apogee Prepress.

3

Find out your Server ID
To find out what that is:
Edit the "Launcher.bat" file located in "Agfa\Prepress\Server" with Notepad.
Search for “/S”, the name after “/S” is the Server ID (in most cases this will be the servername).

4

Verify your original version number of Apogee Prepress (6.0/7.0/7.1).

5

Start D_UpgradeJobs.exe via commandline tool with the correct arguments:
D:\Agfa\ApogeeX or Prepress\Server\ SupportFiles\Utilities\SetupConfigUpdate\D_UpgradeJobs.exe
<Server ID> <original version number>
Wait until the Job Upgrader finishes and reports ‘Successfully finished JobUpgrader’.
Contact Agfa HQ if this is not the case.

6

Set JobStore back to regular mode via the Service Tool > Core Server (a) > JobStore NoRecovery mode (p) >
Registry Key (a).
NoRecoveryMode is now Disabled.

7

Restart Apogee Prepress.

Apache Tomcat does not start
1

Java Virtual Machine of Apache Tomcat (Configure>Apache Tomcat>JAVA tab) must be configured like this:
C:\Program Files\Java\jre1.5.0_22\bin\client\jvm.dll
NOTES:
- This issue will probably occur on computers on which Java(TM) 6 Update [x] has been installed however
some JAVA 6 updates (for instance JAVA 6 updates 35 and 37) do not seem to cause a startup problem. We
do not have a list of which JAVA 6 updates are working and which not.
- On some computers you will see that the Java Virtual Machine path sometimes contains a double back
slash (C:\Program Files\Java\jre1.5.0_22\\bin\client\jvm.dll). This is strange however it does not seem to
cause a problem.
- The Java Virtual machine path is different on 64-bit Operating Systems (client replaced with server):
C:\Program Files\Java\jre1.5.0_22\bin\server\jvm.dll.

Manual install Apache Tomcat
1

Normally the upgrade installer will add Apache Tomcat if it was not installed before the upgrade and it is
required after the upgrade. There is also a small script to perform the Apache Tomcat Installer manually:
\installers\JMFWebServer\Scripts\Install_Apache_Tomcat6.vbs
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22. Replacement of 6.0.0 Task Processors and/or parameters
The following Task Processors are no longer supported: PDFReady, Render and Press. Therefore the upgrade
installer needs to replace these Task Processors according to specific rules. The same rules are applied when
importing archives or tickets from previous versions.
Several Export Task Processor settings have been moved to other Task Processors: the "PDF Format" options
are moved to Apogee.

22.1. Upgrade Installer
Render - PDFRender
The upgrade installer will replace each Render Task Processor with a PDFRender Task Processor.
6.0.0

8.0.0 (after upgrade)

1 Render (no PDFRender)

1 PDFRender

1 Render (1 PDFRender)

1 PDFRender

2 Render (no PDFRender)

2 PDFRender

2 Render (1 PDFRender)

1 PDFRender

PDFReady - Apogee Preflight
The upgrade installer will add an Apogee Preflight Task Processor (if it was not yet installed) when an Export
Task Processor was installed.

Press - Generic Press
The upgrade installer will always install the Generic Press and will remove all Press Task Processors.
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22.2. Production plans, resources, parameter sets, configuration
PDFReady and Render
The PDFReady Task Processor performs flattening and PDFTrapping. Flattening can be performed by
PDFRender and Apogee Preflight. Trapping can be performed by PDFRender. Depending on the job ticket we
will replace tickets with a PDFReady Task Processor with tickets with an Apogee Preflight and /or
PDFRender. This is described in the Figures below.

Figure 1:6.0.0 job ticket with PDFReady and Render

Figure 2: 8.0.0 job ticket (PDFReady and Render are replaced with PDFRender)
The PDFTrapping parameters will be copied to the PDFRender (settings are 100% identical). The
PDFTrapping Parameter Sets are not automatically copied to the PDFRender Trapping.
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PDFReady, Export and Render

Figure 3: 6.0.0 job ticket with PDFReady, Export and Render
NOTE: Upgrading PDFTrapping jobs with an export flow will move trapping to PDFRender of Export flow
also. Exported PDF file will not be trapped but trap settings will be included in exported document.

Figure 4: 8.0.0 job ticket (PDFReady and Render are replaced with Apogee Preflight and PDFRender)
WARNING: Apogee Preflight Task Processor is placed in front of the Export flow and not in the main flow.
Apogee Preflight must perform the flattening for the Export results but we want the PDFRender
to perform the flattening in the main flow. This is the recommended workflow to get the most
accurate results for the main flow. The disadvantage is that the results for the Export flows
might be different.
Apogee Preflight in Export flows will always have the "Transparency Flattening" Action list selected.
The only possible "PDF Format" setting for the Export Task Processor in 7.0.0 is "As Is". Below we indicate
how we convert the PDF Format settings of 6.0.0 Export to 8.0.0 Apogee Preflight.

Figure 5: "Apply color settings" PDF Format in Export is moved to Apogee Preflight "Apply Color Settings" Action List.
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Figure 6: The "PDF Format" options in Export are moved to Apogee Preflight "Job Profiles".
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Apogee Preflight


Color Management:

The configuration settings of Apogee Preflight 8.0.0 do not have a Processing tab any more. In earlier
versions of Apogee Prepress this tab could be used to set the required color profiles for flows that did not
have a PDFRender and Press Task Processor.

Figure 7: Apogee Preflight 6.0.0-7.0.0-7.1.0 Configuration
Apogee Preflight 8.0.0 provides an Input Tagging (Expert) action which provides the possibility to define the
required Input Profiles. The required output profiles can be selected via the Apogee Preflight "Color" action:
Convert2Gray or Convert2CMYK.
This change is not covered by the Upgrade Installer (you need to adjust some jobs manually).


Apogee Preflight Actions:

The upgrade installer will replace all Apogee Preflight Actions with an 8.0 version. The Regional Action lists*
are not upgraded to an 8.0.0 version (they are no longer on the 8.0.0 DVD).

Figure 8: Regional Action Lists which are not upgraded to 8.0.0
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You can still use these Action Lists but we will no longer support them in 9.0.0. We recommend that you
replace the Regional Action Lists with customized Action lists using the available Editable Action Lists (or
combinations of multiple Action Lists).
* Regional Action Lists start with FR_ or RN_ ...; FR indicates France where RN indicates Region North.


Apogee Preflight Profiles

Most Apogee 6.0.0/7.0.0/7.10 Preflight Profiles will be upgraded to an 8.0 version (see Info tab of the
Profile: v8.0.0).

Figure 9: Upgraded profile example
Some Apogee 6.0.0/7.0.0/7.10 Preflight Profiles will not be upgraded to an 8.0 version.

Figure 10: Not upgraded Apogee Preflight profile
HQ - Mortsel
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We do no longer provide these Profile when performing a clean install. We recommend to remove these old
Profiles from your system. Please use the 1v4 versions of the GWG profiles. You will manually need to adjust
jobs when they use these old Profiles.
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Render Specific
The Render Task Processor performs identical operations as the PDFRender therefore all tickets using
Render Task Processor will be replaced with tickets with a PDFRender Task Processor.

Figure 11: 6.0.0 ticket with Render Task Processor

Figure 12: 8.0.0 ticket (Render replaced by PDFRender)
WARNING: The 8.0.0 ticket (with PDFRender) does not have a Normalizer therefore reprocessing upgraded
jobs with PostScript input will generate an error (PDFRender does not support PostScript
input). The user must manually insert a Normalizer Task Processor.
The Trapping, Separating and Screening operations of the Render have 100% identical settings as the
PDFRender Task Processor. Therefore these parameters will be copied to the PDFRender. The Parameter Sets
will also be copied to the PDFRender.
The Render operation provides different parameters for both Task Processors. There are three sections in the
Render operation: PostScript Color Management, Overprint and Missing Fonts. All options for Overprint and
Missing Fonts are also available in PDFRender therefore these can just be copied.
WARNING: The options "knockout All", "Standard Overprint" and "Enable DeviceGray Overprint" are not
available in PDFRender. Therefore this setting gets lost when converting to PDFRender, there is
no warning.
There are significant differences in the PostScript Color Management section therefore we try to select the
best match according to the rules below.
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RENDER POSTSCRIPT COLOR MANAGEMENT MAPPING TO PDFRENDER COLOR MANAGEMENT
We have only provided the CMYK mapping however the same rules apply for the RGB and Gray. The Line-Art
settings follow the same rules if applicable.

Figure 13: Render-CMS-CMYK conversion when using Profiles.
The Blackpoint compensation can only be enabled when there is a PDFReady in the flow.

Figure 14: Render-CMS-CMYK conversion when using Device Links
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WARNING: The "Absolute Colorimetric" Rendering Intent of Render is mapped to "Relative Colorimetric"
Rendering Intent of PDFRender.
The "Overrule rendering intent for LAB images" Render option does not have a PDFRender
counterpart. Therefore this setting gets lost when converting to PDFRender, there is no
warning.
Note that the following message is given when a converted Render job starts rendering. The message is
always generated even when all results have been processed with PDFRender.
APR-52226: Message is only given when importing job archives and job tickets (also ticket templates).
message is not given for converted job tickets or hot tickets.

Figure 15: Warn user that the original ticket contained a Render.
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Press
All Press Task Processors will be removed. The Press parameter sets and their configuration will be merged
into Generic Press Parameter Sets. The Generic Press Parameter Set names will be a combination of the Press
name and the Parameter Set name.

Figure 16: Press Parameter Sets and configuration merged into Generic Press Parameter Sets.
The Press Name is specified in the Type tab of the Generic Press Parameter Set.
All Press resources will be moved to Generic Press.
WARNING: Make sure that each Press resource has a unique name. If the name is not unique then you will
have multiple Generic Press resources with the same name.
The Press Task Processor in job tickets will be replaced with the Generic Press Task Processor with the correct
Parameter Set selected.
NOTE:
When you Import Press Parameter Sets with Configuration Manager they will also be converted to the
Generic Press however the Parameter Sets must be in the original Configuration Manager export folders
together with the Press Configuration Settings. We do not support importing (CPSI) Render Parameter Sets
with Configuration Manager.

TechNote - Company confidential

HQ - Mortsel

32 of 32

UPGRADE CHECKLIST - APOGEE PREPRESS 8.0.0

JDFServer - Planless submission
The JDF PrePressPreparation Expansion settings will be removed. These settings are moved to the JDFImport
parameters.
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